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Trademarks

Microsoft is a U.S. registered trademark of Microsoft
Corporation.

Windows and MS-DOS are trademarks of Microsoft Corporation.

IBM, PC, AT, XT are registered trademarks of International
Business Machines Corp.

Other brands and product names herein are trademarks or
registered trademarks of their respective holders.

Copyright

All rights reserved. No part of this publication may be
reproduced, transmitted, transcribed, stored in a retrieval system,
or translated into any language or computer language, in any
form or by any means, electronic, mechanical, magnetic, optical,
chemical, manual, or otherwise, without the prior written
permission of Avision Inc.

Material scanned by this product may be protected by
governmental laws and other regulations, such as copyright laws,
the customer is solely responsible for complying with all such
laws and regulations.



iii

Warranty
The information contained in this document is subject to
change without notice.

Avision makes no warranty of any kind with regard to this
material, including, but not limited to, the implied warranties
of fitness for a particular purpose.

Avision shall not be liable for errors contained herein or for
incidental or consequential damages in connection with the
furnishing, performance, or use of this material.
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FCC Radio Frequency Interference Statement

This equipment has been tested and found to comply with
the limits for a class B digital device, pursuant to Part 15 of
the FCC rules. These limits are designed to provide
reasonable protection against harmful interference in a
residential installation. This equipment generates, uses, and
can radiate radio frequency energy and, if not installed and
used in accordance with the instruction manual, may cause
harmful interference to radio communication. However,
there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more
of the following measures:

* Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and receiver.
* Connect the equipment into an outlet on a circuit different from 

that to which the receiver is connected.
* Consult the dealer or an experienced radio/TV technician for 
   help.

CAUTION: Any changes or modifications not expressly
approved by the manufacture of this device could
void the user's authority to operate the equipment.
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1. Introduction

Congratulations on your purchase of Avision AV100III color
image scanner.  Avision Inc. is one of the leading companies in
the world to develop high performance sheet-fed scanners.

Before you install and operate the new scanner, please take a few
minutes to read through this manual.  It provides you with the
proper instructions on how to unpack, install, operate and
maintain the scanner.

Figure 1-1 shows how the scanner is packed.  Please check all
the items against your checklist.  If you did not receive all the
items, please contact your authorized local dealer immediately.
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Figure  1-1 Scanner packing

PAPER STAND



2. Scanner Installation
Precautions

* Keep the scanner out of direct sunlight.  Direct exposure to
the sun or excessive heat may cause damage to the unit.

* Do not install the scanner in a humid or dusty place.
* Be sure to use the proper AC power source.
* Place the scanner securely on a level surface.  Tilted or

uneven surfaces may cause mechanical or paper-feeding
problems.

* Retain the scanner box and packing materials for shipping
purposes.

2.1 Installation of the Scanner
Please unpack the scanner carefully, and check the contents
against the checklist.  If any items are missing or damaged,
please contact your dealer immediately.

Installation of the slide guides, the paper guide and the
paper stand.  (See Fig. 2-1)

Open the scanner front door by slightly pulling it away
from the unit.

Insert the paper guide into the center notch located on
top of the unit.

Insert the two slide guides to the left and right of the
paper guide.  When properly installed, the guides should
move freely from side to side.

Insert the two ends of the paper stand into the small
holes on both sides of the paper guide.

Close the scanner front door.
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Figure 2-1 Install the slide guides, the paper guide and the paper stand.
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Document loading

Standard paper size should feed easily through the scanner. To
avoid occasional paper jam or double feed when automatically
feeding multiple documents, loosen the paper before loading.
(Figure 2-2)

Figure 2-2  Loosen the paper before loading.

Document feeding

Insert the document to be scanned face down in the scanner.
Align the two sides of the document with the slide guides.
(Figure 2-3)

Figure 2-3  Place documents in the ADF.
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Scanning Small Documents
To scan small documents, such as business cards, exchange the
positions of the two slide guides, adjust the distance in between
so that it suits the size of the document, and hand feed the
document. (Figure 2-4)

1.  Open the scanner front door.

2.  Remove the two slide guides.  Exchange their positions
and reinsert them with the left guide going now to the
right and the right now to the left.

3.  Close the scanner front door.

Figure 2-4  Exchange the positions of the two slide guides.
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2.2 Connecting the Cable

Be sure the scanner power is off.

Connect the power cable and signal cable as shown below.

Figure 2-5  AV100III scanner cable connection
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3. Scanner Driver Installation
To run at rated speed, the AV100III color image scanner must
have the following minimum requirements:

* IBM compatible PC 386/486 or Pentium;
* Microsoft Windows 3.1 or Windows 95;
* DOS 5.0 or higher;
* One printer port available (enhanced parallel port

recommended);
* 2 megabytes of available hard disk space for installation;
* 4 megabytes of RAM (8 megabytes or higher recommended);
* A video graphics array (VGA) monitor;
* A Microsoft Windows-compatible pointing device (e.g.,

the mouse);
* A 3.5" floppy disk drive.

3.1 Auto-Installation Program
Installation procedure of Avision scanner driver with Avision
Auto-installation Program is as follows:

1. Start Windows 3.1 or Windows 95.
2. Insert Avision Sheet-fed driver into your disk drive.

For Windows 3.1 or Windows 3.11 (See Figure 3-1,3-2)

3. From the File Menu, choose RUN, type a:\setup.exe or
b:\setup.exe, and then click O.K.
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For Windows 95

3. Press the Start button, choose RUN, type a:\setup.exe or
b:\setup.exe (the drive in use), and click O.K.

4. Follow the instructions on the screen to complete the
installation (usually just clicking O.K. will complete the
installation).

Fig. 3.1

Fig. 3.2



3-3

3.2 An Example of  CONFIG.SYS

The installation will add the line
DEVICE=C:\AV3C\DRVR\AV3C.SYS
in the CONFIG.SYS file.

CONFIG.SYS

DEVICE=c:\ WINDOWS\HIMEM.SYS
DEVICE=c:\ WINDOWS\EMM386.EXE noems ram
BUFFERS=40,0
DOS=UMB,high
BREAK=ON
DEVICE=C:\DOS\ANSI.SYS
SHELL=C:\COMMAND.COM C:\ /E:1024 /P
DEVICE=C:\AV3C\DRVR\AV3C.SYS
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3.3 Uninstall the Scanner Driver
You can uninstall the scanner by simply double-clicking on the
Uninstall icon stored in the Avision Sheet-Fed Driver group.

... 

Avision Sheet-Fed

Avision Sheet-Fed
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4. Scanner Operation & Document Printing

There are two types of application software interface to use with
AV100III color image scanner.  They are TWAIN and ISIS.
TWAIN is the most popular interface among image-editing
application software, while ISIS is most popular among archiving
application software.

Scanning Images from within an Application (TWAIN)

Open your application and choose Select Source from the
File menu.  If the Select Source menu options are not
available from the File menu, see the user’s guide of your
application to learn how the TWAIN link is used.

A dialog box appears containing the different TWAIN
sources you can choose to bring an image into your
application.

Select Avision Sheet-fed as the source.

You need to select Avision Sheet-fed for just once except
when you have used the dialog box to select a different
source.  In that case, you will need to select Avision Sheet-
fed as the source again before you can resume your use of
AV100III color image scanner.

Do Calibration: Place a sheet of white, A4-size paper on
the ADF and press the Calibration button to do
calibration.  This should be done each time you power on
the scanner to use.  Also, It is suggested you do it after the
scanner has been powered on for 2 minutes, so that the
lamp may have enough time to warm up.  Or you should
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do this whenever the scanned image seems to be too dark.

Place the image to be scanned face down on the scanner.

From the File menu, select Acquire.

Avision Sheet-fed TWAIN user interface will pop up on
the screen.  Click on the Prescan or Scan button to get
the image.

The TWAIN user interface:
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4.1 Image Type
You can select the Type menu for the mode you want to use with
your document or image.

Line art

Line art includes only black and white areas.
There are no intermediate shades of gray in
between.

Halftone

Halftone simulates different shades of gray by
varying the threshold value of a matrix.

Error Diffusion

While taking up but a minimum storage space,
error diffusion gives good image texture and
excellent image details.

Gray (256 levels gray scale)

Scanner recognizes each point in the image as a 
shade of gray (continuous tone).  8-bit gray gives 
more detailed information about the image.

True Color (16.7 million colors)

Color image have continuous tones along with its
color hues.



4-4

Note:  For best OCR and article print-out effect, we recommend
the scanning parameters to be that of 300 dpi, black and
white mode.  To scan pictures or photos, the color or gray
scale mode is necessary  But then, these modes invariably
take up much more disk space.  An A4-size color image
scanned at 300 dpi, for instance, takes up as much as
24MB of disk storage space.  To save disk space, then,
we suggest you set the scanning resolution at 100 dpi for
those images intended for screen display use only, now
that a scanning resolution of 100 dpi can do quite all right
for the said purpose.

4.2 Resolution Control
Resolution: The number of dpi (dots per inch) that AV100III

uses for a scan.
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4.3 Image Control
Brightness: Adjusts the lightness or darkness of an image.  The

higher the value, the brighter the image.

Contrast: Adjusts the range between the darkest and the
lightest shades in the image.  The higher the
contrast, the bigger the different gray scales range.

Gamma: Adjusts the midtone of the image without losing
details of the lightest and the darkest areas.

Highlight: Adjusts the highlight area of the image.

Shadow: Adjusts the darkest area of the image.

Channel: Used along with the five functions above, this
function enables you to select RGB for Red,
Green, or Blue filter to display the color image the
way you desire.

Color Filter: You can select None, Red, Green or Blue filter for
color drop out purpose when in line art / halftone /
error diffusion / gray mode.  For instance, a text
with a red background color hampers the reading.
In this case, then, you can select RGB for the Red
filter to drop out the background color and
facilitate the reading.

Brightness

Shadow

Gamma

Highlight

Shadow
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Invert:                The invert command reverses the brightness and
the color in the image.  For color images, each
pixel will be changed into its complementary
color at the command of Invert.

                         

Color Match:    Adjusts the color quality of the image so that it
comes close to that of the original.  This
function uses default parameters to adjust the
image.

                          

Filter:               Gives you special effects on the image.  You can
select the Filter function from the menu bar.

                         

Descreen:    Eliminates moire patterns commonly found in
printed matter.  The Descreen function can be
found in the pull-down Filter menu.
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Before Descreen

After Descreen
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4.4 Scanning
Cm Indicates you are currently using the metric system.

You can switch to the British system by clicking the
Cm abbreviation.  The two systems represent a
toggle switch.

Prescan: Previews your image roughly and allocates the area
to be scanned.

Scan: Scans the area with the parameters you have set.
Cancel: Cancels the current job.

As shown in the illustration below, in the Preview window, you
can define the area to be scanned by dragging the cursor auxiliary
lines.

Click here to shift between different systems

The Preview

Window

Cursor
Auxiliary
Lines
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4.5 Printing
Connect the printer cable as shown in Figure 4.1.

Figure 4.1 Printer cable connection

Attention:

1. Be sure to power on the scanner if you want to do pass-
 through printing.

2. Do not scan and print at the same time.
3. If your PC does not support EPP mode or have pass-through

compatibility problem, please contact your authorized local 
dealer for an EPP card or an additional interface card.
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4.6 Scanner Control Center
Having finished your use with the scanner, you may want to turn
it off.  The Avision Sheet-fed scanner is not equipped with
switch in view of system considerations.  However, you can turn
off the scanner through the software switch called Scanner
Control Center: Just right click on the icon and select the Switch
Off item.  Scanner Control Center can be found in the Avision
Sheet-fed Driver group.

... 

... 

Avision Sheet-Fed
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5. Maintenance

5.1 Cleaning the ADF

Your scanner is designed to be maintenance free.  However, it
still needs to be cleaned (especially, the pad and the feeding
roller) occasionally to ensure optimum image quality and
performance.

The scanner parts may be contaminated with ink, toner
particles or paper coatings.  As a result, the scanner will need
to be cleaned frequently in case:

1) Documents do not feed smoothly or easily;
2) Several documents feed at the same time.

The cleaning procedures (See Figure 5-1)

1)    Soak a cotton swab with some isopropyl alcohol. (95%).

2)  Open the scanner front door and wipe the upper feeding
roller by moving the swab from side to side.  Rotate the
roller forward with your finger and repeat the cleaning
steps above until the entire roller is cleaned.  Be careful
not to damage the pick springs.

3)  Wipe the pad in one and the same direction, top down or
bottom up.  Be careful not to damage the pick springs.

4)  Wipe where the window glass is contaminated, which is
manifested by the constant appearance of a vertical line on
some specific part of the scanned image. (See Figure 5-2)
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5)  Close the scanner front door.  Your scanner is now ready
for use.

Figure 5-1  Open the scanner front door.
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5.2 Cleaning the Window Glass
As shown in Figure 5-2, clean the window glass with an air-
blower or a small brush to rid the glass of dust or dirt.  Please
handle with care and dexterity.

Figure 5-2 Clean the window glass.
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6. Troubleshooting
The scanner will automatically perform a simple self test
each time it is powered on.  This will help spot major
system errors in the scanner itself.

If you have any problem with the operation of the scanner,
please check the following troubleshooting hints.
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6.1 Questions and Answers

Question: Paper becomes jammed during scanning.
Answer: 1) Open the scanner front door.

2) Pull out the jammed paper carefully.
3) Close the scanner front door.

Question:  More than one sheet of paper are fed into the
scanner.

Answer: 1) Open the scanner front door.
2) Remove the multi-fed sheets of paper.
3) Close the scanner front door.
4) Flatten the corners and edges.  Loosen the

paper before putting it into the paper guide 
again.

5) Check the feeding roller condition.  If
necessary, follow the cleaning directions in
section 5.1 and do the cleaning.

Question: Paper becomes skewed in the scanner.
Answer: 1) Use the slide guide to keep the paper path 

straight.
2) Check feeding roller condition.  If necessary,

follow the cleaning directions in chapter 5.1 and
do the cleaning.

Question: Why is it that the scanned images always come
out to be too dark?
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Answer: 1) Modify the Gamma setting to 1.8 for your
monitor and, when printing, set Gamma to 2.2
for your printer.

2) Use the Brightness setting of the TWAIN user
interface to get a brighter image.

Question: Why does my scanner scan at a very low speed?
Answer:    If you have installed “Works for Windows,” it

will install Window Printing System (WPS) in
your WIN.INI file.  This will share the printer
port time remarkably.  You can remove the WPS
from your WIN.INI file, as follows:

From:
[MS Text Converters]
MSWorksWin=Works for Windows 2.0,C:\WINDOWS\MSAPPS\TEXTCONV\worksdos.cnv,wps

Works for Dos 2.0=Works for DOS 2.0 MSAPPS\TEXTCONV\workswin.con,wps

To:
[MS Text Converters]
MSWorksWin=Works for Windows 2.0,C:\WINDOWS\MSAPPS\TEXTCONV\worksdos.cnv

Works for DOS 2.0=Works for DOS 2.0, C:\WINDOWS\MSAPPS\TEXTCONV\workswin.con

Question:  A problem occurs when the printer is printing the
documents.  What can I do?

Answer:    Pass-through printing may pose a problem for
some printers.  It is suggested that you

                  a) add a second printer card for printing purpose,
or,

                  b) add Avision scanner interface card IF05 to
perform scanning.

                  Please call your authorized local dealer for
support.
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Question: The scanning speed of my scanner is much
slower than that of those installed at other
computers.  Can I speed it up?

Answer:     In such case, please
                   a) Set you PC printer port to the EPP mode from

BIOS setting, or,
                   b) Add Avision scanner interface card IF05 to

scan at a higher speed.

Question:  Does it take long for the scanner to initialize?
Answer: If your printer port supports SPP mode only, it

takes a minute or so for the scanner to initialize.
If your printer port supports EPP mode, the
initialization process is much faster, can be done
in about 20 seconds.  Generally, it takes a two to
three minutes time for AV100III scanner lamp to
warm up.  It may be that your scanner lamp is out
of order if it works otherwise.

Question:  Sometimes it seems the scanner does not detect
paper?

Answer: The AV100III scanner’s paper sensor is located
central of the paper guide.  Please place whatever
you want to scan somewhere thereabout and use
the slide guides to keep the paper path straight.

Question:  Why sometimes pass-through printing does not
work at all?

Answer: It may be that you forgot to power on the
scanner.  When doing pass-through printing, first
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and foremost, please remember to power on the
scanner.  Else, without power, the scanner can
not transfer the printing data/signals to the
printer.

Question:  Why doesn’t my GDI printer work with
AV100III scanner?

Answer: Disable the “Auto Scan” function in the
application, and your printer will function all
right.

Question:  Why some parallel port devices and software’s
keypro do not work with AV100III scanner?

Answer: The AV100III scanner can do pass-through
printing all right, but not otherwise.  As such, if
you would like to connect some parallel port
devices other than printer, please do not connect
them to the same parallel port that AV100III
currently uses.  It is advisable that you use other
parallel ports to connect these devices or keypro.
For instance, you can connect AV100III scanner
to LPT1, and connect other parallel port devices
to LPT2.  Or you can add a data switch to avoid
the problem.
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6.2 Technical Service
Technical support for Avision scanner is provided at the
Avision Technical Assistance Center (ATAC).  Before you
contact with ATAC, please prepare the following
information:
* Scanner serial & revision number (located on the bottom 

of the scanner);
* Hardware configuration (e.g., your host CPU type, RAM

size, free disk space, display card, interface card...);
* The name and version of your scanning software 

application;
* The version of your scanner driver.

Please call us at:
US and Canada Area:
Avision Labs., Inc.
Address                 :48521 Warm Springs Blvd. #312

Fremont, CA 94539
Telephone number :510-440-8785
Fax number  :510-440-8337
Web Site  :http://users.aimnet.com/~avision
E-mail  :avision@aimnet.com
Other Area:
Avision Inc.
Address                 :No.20, Creation Road I, Science-Based

Industrial Park, Hsinchu, Taiwan, R.O.C.
Telephone number :886-3-5782388
Fax number :886-3-5777017
BBS :886-3-5786149
CompuServe :101400,444
Email :service@avision.com.tw
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Note: 1. You can find the latest driver and documents
    in Avision BBS.  Our service is 24 hours a day.
    The communication setting is:
    2400-19200 BPS, 8N1S.
2. You will be asked to enter your first name, last

     name and password at all times.
   3. For first-time user, you will be requested of your

full name and password.  The same name and same
password are required to enter BBS again next
time.
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7. Specifications

All specifications are subject to change without notice.

The following can not be properly fed by ADF:

* Paper with clip or staple attached;
* Paper with ink not totally dry;
* Paper with inconsistent thickness, such as envelopes;
* Paper with wrinkles, curls, folds or tears;
* Tracing paper;
* Coated paper;
* Carbonless paper;
* Paper narrower than 3.5" or wider than 8.5";
* Items other than papers, such as cloth, metal or
   OHP film;
* Notched paper;
* Paper with an odd (non-rectangular) shape;
* Very thin paper.
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7.1 Model: AV100III

Scanner Type: Desktop Sheet-fed
Optical Resolution: up to 300 dpi * 300 dpi (H*V)
Scanning Modes: Black & White mode

Halftone mode (64-step)
Error diffusion (2 patterns)
8-bit gray scale (256 levels)
24-bit color (16.7 Millions of color)

Document Feed: Auto Document Feeder (ADF)
ADF Capacity: up to 10 pages
Scanning Speed: 6 pages per minute (200 dpi, line

art, letter size)
Document Size Letter, legal, A4, B5, A5, business

           card
Min. Document Size: 4" x 3.5" (ADF)

3.5" x 2" (manual feed)
Paper: 16 lb. to 24 lb.
Interface: Printer port
Power Source: 110Vac or 220Vac, 50-60Hz,
                                               external
Power Consumption: 12 watts (12Vdc,1A)
Dimensions: (WxHxD) 293 mm x 89 mm x 107 mm
Weight: 3.5 lbs.
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EC Declaration of Conformity

According to EN45014
Manufacturer's Name: AVISION INC.
Manufacturer's Address: No. 20, Creation

Road, Science-Based
Industrial Park, 
Hsinchu, Taiwan, 
R.O.C.

declare that the product

Model Number : Avision Sheet-fed

conforms to the following Product Specifications:

Emission:   EN 50081-1 (1992)
  EN 55022 (Class B)
  (Conducted  Radiated) (1994)
  EN 60555-2 (Harmonics) (1987)
  EN 60555-3 (Flicker) (1987)

Immunity:
  EN50082-1 (1992)
  IEC 1000-4-2 (ESD) (1995)
  IEC 1000-4-3 (RS) (1995)
  IEC 1000-4-4 (EFT/Burst) (1995)

  IEC 1000-4-5 (SURGE) (1995)

Date:   December, 1995


